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Fig. 5. Under-oil co-culture, cell function of primary colon epithelium, and growth kinetics of 
anaerobic bacteria (()# *"!+%',!- ). (A) Schematic shows the workflow of tissue processing, organoid 
generation, establishment of colon monolayer, and inoculation of bacteria. The volume of media is 40 μl/well 
for 4 mm in media depth. The volume of oil (silicone oil, 5 cSt) is 50 μl/well for 5 mm in oil depth. (B) Three-
dimensional (3D) laser confocal image with z-slices and fluorescent images from the under-oil mono-culture 
of colon monolayer on Day 9. Scale bars, 100 μm. (C) POC (O2, %) measured on Day 9 (i.e. at 48 h from 
adding the oil overlay) along with two no-bacteria mono-culture conditions (i.e. colon monolayer only with 
and without oil overlay). Data were pooled and averaged with a minimum of ×3 replicates of each condition. 
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(D) Bacteria count [at 30× magnification, with a field of view of 446.5 μm (length) × 445.6 μm (width)] in E. 
(E) Microscopic images (30× magnification) showing the growth in mono-culture (bacteria only) with and 
without oil overlay compared to co-culture (colon monolayer + bacteria) under oil. The fluorescent images 
were all processed with normalized LUTs for visualization. The 24 h B. uniformis images (in the dashed line 
box) were rendered with pseudocolor (red) to visualize the bacteria (Materials and Methods). Scale bars, 
200 μm. (F) RT-qPCR [ΔCt (i.e. cycle threshold)] results for comparison of gene expression (table S3) of 
the colon epithelium. Lower ΔCt values indicate higher gene expression. Data were pooled and averaged 
with ×3 replicates of each condition. Error bars, mean ± s.d. *P ≤ 0.05, **P ≤ 0.01, ***P ≤ 0.001, and ****P 
≤ 0.0001. 
 
substantially different in the mono-culture and co-culture conditions at 48 h based on the POC 
measurements [Fig. 5C, B. uniformis (no oil/oil) versus Colon + B. uniformis (oil)]. To further characterize 
the effect of oxygen on the growth of B. uniformis in the co-culture, we performed a co-culture experiment 
under fluorinated oil (fig. S8). Compared to silicone oil, fluorinated oil has low moisture and high gas (e.g. 
O2, CO2) permeability (table S1). As shown in fig. S8, little hypoxia was generated from the co-culture of 
the host cells (Caco-2) and the bacteria under fluorinated oil compared to co-cultures under silicone oil. 
Importantly, no growth of B. uniformis was observed in the co-culture performed under fluorinated oil in 
contrast to the growth observed in the co-culture under silicone oil. While factors beyond oxygen may affect 
the growth of B. uniformis, the fluorinated oil control experiment suggests that elevated oxygen may 
contribute to the impaired growth of B. uniformis in this co-culture relative to the silicone oil overlay. 

The IFS analysis showed that expression of epithelial differentiation markers in colon monolayers 
were similar in presence and absence of B. uniformis (fig. S7), suggesting that the presence of B. uniformis 
did not significantly disrupt the epithelium. To investigate the impact of B. uniformis and UOMS cell 
culture on colon monolayers at the transcriptional level, we examined the expression of gene markers 
associated with epithelial cell function, including cell proliferation (MKI67) and cell lineage (Axin2, TFF1, 
SI and MUC2) (table S3). Our results showed that all investigated genes were robustly detected in all 
conditions (no oil overlay, oil overlay and B. uniformis co-culture with oil overlay) by RT-qPCR (Materials 
and Methods). In addition, there were no significant changes in the expression of the proliferation marker 
gene (MKI67) and majority of characteristic cell lineage markers associated with differentiation (Axin2, 
TFF1, SI and MUC2) in response to UOMS cell culture (Fig. 5F). Notably, high abundance of B. uniformis 
did not significantly alter the differentiation status of the epithelium according to the subset of genes 
examined, which is consistent with the IFS analysis results. However, our results indicate that the colon 
monolayer expression of villin, associated with brush border microvilli expressed by absorptive 
enterocytes, was upregulated in the conditions with UOMS cell culture compared to the control (i.e. no oil 
overlay) condition. Future studies are required to determine if the UOMS cell culture facilitates microvilli 
differentiation by upregulating the expression of villin and to confirm microvilli formation. Together, these 
results lend support to the hypothesis that the reduced oxygen level enabled by AROM in UOMS cell 
culture can establish a more favorable environment for the growth of strict anaerobes such as B. uniformis.  
 
DISCUSSION 
The critical role of oxygen in living systems is increasingly understood, however, precise monitoring and 
control of oxygen levels are often neglected in cell culture studies. Many studies have highlighted the 
importance of mimicking in vivo physiological conditions (e.g. temperature, pH and the partial pressure of 
oxygen and carbon dioxide of the cellular microenvironment), to improve modeling of specific cellular 
microenvironments in human physiology and disease. Nevertheless, employing a physiologically 
inconsistent oxygen microenvironment in cell culture is still a widely existing pitfall, which likely 
contributes substantially to differences between in vivo and in vitro results (15). While the development of 
microfluidic cell culture enables precise control of the cellular microenvironment compared to standard cell 
culture, oxygen microenvironments that allow cellular control of the oxygen levels and achieve homeostasis 
(i.e. supply-demand-defined balance) are lacking due to the material properties and small scale nature of 
microfluidic technologies. In this work, we introduce UOMS cell culture, which provides a reliable method 
capable of recapitulating a range of oxygen levels via autonomous regulation by cells and control over the 
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supply of oxygen. Oxygen regulation by cells allows for establishment of feedback loops wherein the 
dynamically changing oxygen demand of cells modifies the oxygen microenvironment, which in turn 
triggers signaling pathways that affect cell functions and phenotypes. Using our method, the oxygen 
microenvironment is not imposed on the cells and is thus distinct from existing microfluidic cell culture 
methods (which primarily employ a supply-defined or demand-defined gas control on the cell culture 
system). By contrast, the cells are allowed to control oxygen autonomously given a tunable supply, which 
resembles the regulation of the oxygen microenvironment in vivo. 

It is worth further clarification that varying oxygen levels including hypoxia can be achieved by 
simply using a large volume of media overlay (fig. S4) rather than the oil overlay. However, the ability to 
operate within and manipulate small volumes (i.e. microliter, nanoliter, or below) of media is an essential 
function of microfluidic cell culture to better mimic in vivo conditions or a natural cellular 
microenvironment. The oil overlay approach provides a practical, robust, and easy-to-adopt method to 
better mimic the oxygen regulation characteristics of in vivo biology in microfluidic cell culture (fig. S5). 
Importantly, the small scale nature and advantage of microfluidic cell culture are not compromised by 
applying the oxygen control with oil overlay compared to applying a large volume of media overlay.  

While this method aims to establish autonomous regulation of oxygen levels for in vitro cell culture, 
it could be applied to other vital gases (e.g. carbon dioxide) in UOMS cell culture using a similar approach 
(fig. S9). For microfluidic cell culture, especially PDMS-based microdevices, the dissolved gases in the 
culture media can rapidly change (due to the ultra-high gas permeability of PDMS elastomer and the small 
scale of the microdevice) if the ambient gas compositions change (e.g. moving the setup out of the incubator 
for intermediate sample manipulation or imaging). While this issue can be mitigated using a gas-regulation 
chamber equipped with a glove box and other tools (e.g. liquid handler, microscope), the complexity of 
such gas-regulation systems burdens the operation and discourages end users from adopting these measures. 
UOMS cell culture minimizes the dependence on a specifically defined ambient for vital gas regulation. A 
culture or co-culture can be established, maintained, and characterized directly in atmospheric ambient 
without using gas-regulation equipment.  

To make the autonomous gas regulation complete as a scientific tool (i.e. being able to establish a 
specific microenvironment and perform quantitative measurements for tracking and investigating the 
process) the local level of such vital gases in the culture media to which the cells are exposed need to be 
effectively monitored. Compared to the culture systems with closed-channel or closed-chamber designs, 
UOMS cell culture allows minimal disturbance of the established cellular microenvironment from external 
interventions. As demonstrated in this work, a microsensor can be introduced through the oil overlay with 
spatiotemporal flexibility to monitor the local oxygen levels at sites of interest. Similarly, cellular samples 
and/or reagents (e.g. drugs, conditioned media) can be easily added to or collected from UOMS cell culture 
without interfering with the gas levels in the cellular microenvironment. Moreover, by arranging different 
cell types and modulating the oil depths or viscosities of the oil overlay, compartmentalized and high-
throughput gas regulation can be realized on one device (e.g. a microtiter plate) with the same ambient 
environment such as in air or in a standard incubator. Temporally changing oxygen levels seen in vivo such 
as fluctuating or cycling hypoxia can be also easily implemented by adding and removing a specific volume 
of oil in the oil overlay (e.g. with a programmed syringe pump) over time. Due to these unique features 
enabled by the under-oil open design, this method could be used for high-throughput screening applications 
(e.g. mutant analysis of bacterial species or antimicrobial drug selection) with controlled oxygen 
microenvironments. 

Recently we reported a breakthrough in UOMS (30): Enabled by the extreme wettability - 
Exclusive Liquid Repellency (ELR, an inherent and absolute repellency of a liquid on a solid surface) (23, 
25), open microchannels can be prepared under oil (silicone oil) with the channel dimensions reduced up 
to three orders of magnitude (from millimeter scale to micrometer scale) compared to previously reported 
techniques. Open-fluid cell trapping (including mammalian cells and bacteria), flow rate range comparable 
to blood flow with open-channel designs, and anti-biofouling reversible open-channel fluidic valves were 
all achieved for their first time in open microfluidics. Designer microchambers/microchannels and versatile 
fluidic control can be easily and robustly realized in UOMS with these recent advances from our lab. One 
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of the ongoing follow-up works is to extend the AROM method to the under-oil open microchannels that 
allow various flow conditions.  

We used the AROM method to investigate inter-kingdom interactions between primary host 
intestinal epithelium and a highly prevalent human gut microbiome species which exhibit contrasting 
responses to oxygen. Our results demonstrated that UOMS cell culture with AROM can be used to study 
the dynamics of inter-kingdom interactions at multiple levels including bacterial growth, host-cell 
phenotypes and gene expression. Future work will investigate the molecular basis of interactions using 
metabolomics, as well as study interactions using a diverse panel of human gut bacterial species and 
microbial communities constructed from the bottom-up. In addition, future studies could investigate the 
genetic determinants of the bacterial growth dynamics in the presence and absence of host epithelium in 
AROM using barcoded transposon libraries (47) and/or deletions of key genes involved in oxygen sensing 
or tolerance (46, 48). Further, the ecological and molecular role of oxygen as a mediating factor in gut 
microbiome dysbiosis could be investigated using AROM. Specifically, shifts in microbial community 
composition, metabolite production and degradation, and host phenotypes could be quantified in response 
to oxygen perturbation in order to elucidate disease relevant host-microbiome interactions and feedbacks 
(49). In addition, we will investigate the integration of 3D organotypic model components (e.g. 
incorporation of crypt/villus architecture, immune cells, vasculatures and media circulation) with the under-
oil oxygen microenvironments. 

The most frequently expressed concerns during the development of AROM in UOMS cell culture 
include: (i) extraction of lipophilic molecules (e.g. lipids) by the oil phase from the culture media; and (ii) 
media change/perfusion with an established oxygen microenvironment. First, for any in vitro cell culture 
model, biocompatibility of the materials used need to be carefully assessed. While the general 
biocompatibility of silicone oil [i.e. pure linear PDMS polymer liquid (without small molecule additives 
and cross-linkers)] in cell culture has been proven and reported, it can cause swelling of PDMS-based 
devices and similar to PDMS elastomer may absorb small molecules which could bias molecular signaling 
studies (e.g. lipid signaling). We have successfully addressed this issue via the use of a layer of fluorinated 
oil (i.e. perfluorocarbon liquid) between the culture media/device and the silicone oil (fig. S5). Fluorinated 
oil has been previously used in cell culture, does not cause PDMS elastomer swelling and retains small 
molecules. A systematic assay on extraction of lipophilic molecules in these aqueous media-oil two-phase 
systems at the level of lipidomics or metabolomics (e.g. using mass spectrometry) is of great importance 
for a broad adoption of UOMS cell culture in biological and biomedical researches and will be the subject 
of future investigations. Second, for in vitro cell cultures that need to be maintained from several days to 
weeks, nutrients need to be replenished via media changes. To minimize interruption to the established 
oxygen microenvironment in UOMS cell culture during media change, we have demonstrated the use of 
partially deoxygenated media described in fig. S3. Deoxygenation of the culture media can be executed in 
a number of different ways including nitrogen gas (N2) bubbling, or a regular degassing/gas-exchange 
vacuum desiccator. The deoxygenated media can subsequently be stored under oil, and monitored using the 
oxygen sensor system as the oxygen level recovers to the target value (i.e. the oxygen concentration in an 
established microenvironment) required for media change. Continuous perfusion of the partially 
deoxygenated media can also be achieved using a peristaltic pumping system. 

 The ability to control physical and chemical characteristics of cell culture in in vitro modeling will 
enable improved function (and relevance) when recapitulating normal and disease states seen in vivo. We 
foresee many potentials of AROM in UOMS cell culture as providing improved capacity to mimic in vivo 
conditions, and as a functionality module that can be robustly and readily integrated into existing in vitro 
culture systems allowing for broad adoption among end users. 
 
MATERIALS AND METHODS 
Preparation of mono-culture plates 
The mono-culture was established in (but not limited to) 384-well plates (Polystyrene, Tissue Culture Treated, Flat 
Bottom, 384-well plate, Corning 3701) with cell culture media corresponding to each cell type (table S2), and with 
silicone oil [Sigma Aldrich, 317667 (5 cSt), 378399 (1000 cSt)] or fluorinated oil (Fluorinert FC-40) (Sigma Aldrich, 
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F9755) overlay. The culture media and oil in this work were not deoxygenated prior to use. The plates were prepared 
in a sterile biosafety hood in air at room temperature (RT, ~22 oC). Specifically, to prepare a mono-culture plate 
include the following steps: #1) Add a certain volume (e.g. 15 or 35 µl/well) of fresh media (stored in a regular 4 oC 
fridge, oxygen saturated) with and without the hypoxia dye (Invitrogen, Image-iT Green Hypoxia Reagent, Thermo 
Fisher Scientific, I14833) (1:1000 dilution in media); #2) Overlay the media with a certain volume [e.g. 0 (for no-oil 
control), 10 or 50 µl/well] of oil; #3) Prewarm the plate in a standard incubator [37 oC, 18.6% O2, 5% carbon dioxide 
(CO2), 95% relative humidity (HR)] before cell seeding; #4) Prepare the cell stock at a specific concentration (e.g. 
2000 or 6000 cells/µl) following the standard cell culture/passage protocol; #5) Pipette 5 µl of the cell stock to the 
media under oil to reach a target seeding density (e.g. 1×104 or 3×104 cells/well); #6) Keep the plate in a standard 
incubator up to 24 h or 48 h without media change. The plates were imaged and measured to get different readouts, 
e.g. cell viability, POC and IOC (see details in Measurement of POC and IOC below). 
Preprocessing of cells in mono-culture 
(i) Preculture of C. albicans. C. albicans fungal cells (CMM16) were inoculated from a streaked plate in 2 ml yeast 
extract peptone dextrose (YPD) [1% yeast extract (BD Biosciences, 212730), 2% peptone (BD Biosciences, 211862), 
2% dextrose glucose (Thermo Fisher Scientific, 215510)] glucose media and grown in an incubator at 30 oC overnight. 
The fungal cells were measured on a spectrophotometer (Thermo Fisher Scientific, 335932) with optical density at a 
wavelength of 600 nm (OD600) and then converted to cell concentration. Serial dilution was performed to reach final 
concentration of 6000 cells/μl in a culture media (table S2) for further experiments.  
(ii) Isolation of neutrophils from whole blood. Primary human neutrophils were isolated from peripheral blood taken 
from healthy donors. All blood samples were drawn according to Institutional Review Boards (IRB)-approved 
protocols per Declaration of Helsinki at the University of Wisconsin–Madison. Peripheral neutrophils were isolated 
by negatively removing all contaminating cells using the MACSxpress Neutrophil Isolation Kit (Miltenyi Biotec, 130-
104-434) and BD Pharm Lyse buffer (BD Biosciences, 555899) for red blood cell depletion, according to 
manufacturer’s instructions. Cells were washed and resuspended in appropriate media (table S2) for further 
experiments. 
Preparation of mono-culture in PDMS microchannels 
The PDMS microchannels (fig. S5) were prepared following a standard photolithography process and O2 plasma 
bound onto a chambered coverglass [Nunc Lab-Tek II Chambered Coverglass, #1.5 borosilicate coverglass (0.16-
0.19mm), biocompatible acrylic adhesive, Thermo Fisher Scientific, 155382]. Collagen type I (Corning, 354249) 
solution prepared with 10× PBS, cell culture media, and 0.5M NaOH at 3 mg/ml was added to the glass surface in the 
microchannels to create a thin layer of collagen coating prior to polymerization. After polymerization of the collagen 
coating at 37 ℃, 30 μl of Caco-2 cells at a concentration of 15000 cells/μl in culture media (EMEM + 20% FBS) were 
seeded into each microchannel via passive pumping and cultured for 24 h. After 24 h cell culture the conditioned 
media (along with the suspension cells) was replaced with a fresh media containing hypoxia dye. The microchannels 
were then overlaid with a 2.5 mm depth of fluorinated oil (Fluorinert FC-40), followed by an additional 5 mm depth 
of silicone oil (1000 cSt). The chambered coverglass with the PDMS microchannels was kept in a standard incubator 
for 48 h without media change before the characterization and imaging on a microscope (see IOC tracked by the 
mean fluorescence intensity of the hypoxia dye).  
Measurement of POC and IOC 
(i) Working principle of the optical oxygen sensor (for POC). The optical oxygen sensor system (Ohio Lumex) 
includes an oxygen meter [FireStingO2 fiber-optical oxygen meter (PS FSO2-2)], a temperature sensor [Teflon-coated 
and submersible, not shielded, Ø = 2.1 mm (PS TSUB21)], an oxygen mini sensor [Ø = 430 μm (OXB430)], and a 
computer installed with Firesting Logger software (Pyro Science). The measurement is based on quenching of near-
infrared (NIR) fluorescence in the presence of molecular oxygen in the media. The quenching of fluorescence is 
described by Stern-Volmer relationship as I0/I = 1 + KSV[O2], where I0 and I, respectively, correspond to the 
fluorescence intensities in absence and presence of oxygen; KSV is the Stern–Volmer constant, and [O2] is the 
concentration of oxygen in the sample. 
(ii) POC measurement with the optical oxygen sensor. The 384-well plate from cell culture was placed on a hot 
plate (40 oC, the set temperature) on the bench. An aluminum bar was applied between the well plate and the surface 
of the hot plate to enhance heat transfer. The temperature sensor was kept in a well (without cells) filled with 50 µl 
deironized (DI) water and with the tip sitting on the bottom of the well to give accurate temperature compensation. 
The system was allowed to stabilize for at least 10 min before the calibration, measurement and data collection. 
Calibration of the optical oxygen sensor was done using the “2-point in water or humid air” mode with the steps as 
follows: #1) Prepare the two calibration liquids. Liquid A - air-saturated DI water for 100% O2 saturation ratio (or 
21% O2); Liquid B - freshly prepared 1 wt% sodium sulfite  (Na2SO3) (≥ 98%, Sigma Aldrich, S0505) aqueous solution 
for 0% O2 saturation ratio (or 0% O2). Add 50 µl of each liquid to a well on the well plate and prewarm; #2) Sterilize 
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the oxygen sensor by submerging the sensor tip in 70% ethanol (Thermo Fisher Scientific, 64-17-5) in an eppendorf 
tube for 10 sec. Then thoroughly rinse the sensor tip with DI water and dry it in air using a rubber bulb; #3) Keep the 
oxygen sensor in Liquid A first until the oxygen readout curve is stabilized at 100% O2 saturation ratio (with minimal 
background fluctuation). Then switch to Liquid B to have the oxygen readout curve stabilized at 0% O2 saturation 
ratio. Thoroughly rinse the sensor tip with DI water and dry it in air using the rubber bulb; #4) Insert the oxygen sensor 
mounted on a linear translation stage (Siskiyou, MX130L) into a well through the oil overlay with the sensor tip resting 
on the cell layer at the bottom of the well to give an accurate readout of POC. Each recording of the POC lasts an 
equal length of time (e.g. 1 min) after the reading is stable. The replicate wells from the same cell type and condition 
are measured in a row without additional treatment of the sensor tip during switch. To switch to a different cell type 
or condition, the sensor tip is sterilized following Step #2 before the next measurement to avoid cross contamination; 
#5) After all measurements finished, clean the oxygen sensor following Step #2; #6) The recorded txt. data sheets 
(O2 % versus time) were pooled together for each condition in Excel and then plotted in Prism GraphPad. 
(iii) Working principle of the hypoxia dye (for IOC). The measuring of the hypoxia dye is based on the uptake of 
the dye molecules into live cells which fluoresce when experiencing a reduced oxygen level inside the cells (i.e. IOC) 
compared to 21% O2. Dead cells release the dye and lose fluorescence. A couple of common pitfalls in using this 
hypoxia dye need to be clarified: #1) The dye only provides a fluorescence readout that can be used to reflect/track 
the drop of IOC compared to 21% O2. The fluorescence intensity from a single condition on itself doesn’t tell any 
specific oxygen levels unless associated to a direct oxygen measurement, e.g. POC measured at the cell layer (which 
is the protocol used in this work): #2) Moreover, the fluorescence intensity can vary with different operation 
parameters including the concentration of the dye in media and imaging conditions (e.g. the bottom material/thickness 
of the well plate, laser intensity, exposure time). A parallel comparison of the fluorescence intensity is valid only if 
the operation parameters are defined and maintained consistent: #3) At last, the brand name of the dye (Hypoxia 
Reagent) itself is apparently based on the conventional definition of “normoxia” with 21% O2, however, inaccurate 
and misleading (50). An increased fluorescence compared to the baseline with 21% O2 may leave the cells exposed to 
an oxygen level anywhere between hyperoxia and anoxia (fig. S1). In other words, it’s worth noting that the hypoxia 
dye doesn't only report hypoxia. 
(iv) IOC tracked by the mean fluorescence intensity of the hypoxia dye. Fluorescent imaging was performed on a 
Nikon Ti Eclipse inverted epifluorescence microscope (Nikon Instruments) with ×3 replicate wells from each 
condition to get the hypoxia dye signal at 4× magnification (to cover the cell layer from the whole well on a 384-well 
plate) with 485 nm/525 nm [Excitation (Ex)/Emission (Em)], maximum laser power, and 1 sec of exposure time. 
Wells with the same cell seeding but without hypoxia dye were imaged for control and background subtraction during 
image processing and analysis of the mean fluorescence intensity. The mean fluorescence intensity was extracted from 
an image (in 16-bit color depth, with and without hypoxia dye) using the “Analyze → Measure” function in Fiji 
ImageJ, with a range of interest (ROI) set to cover the cell layer but exclude the edges of a well. The mean fluorescence 
intensities of images with hypoxia dye were subtracted with the average of the mean fluorescence intensities from the 
control without hypoxia dye. 
Oxygen diffusion test of silicone oil 
1 ml of culture media (DMEM + 10% FBS) was pipetted to a 5 ml centrifuge tube (polypropylene, Argos, T2076A). 
The oxygen sensor was submerged in the media with the tip being kept about 1 mm from the air/media interface (fig. 
S3). A stainless steel blunt needle (18G, SAI Infusion Technologies, B18-150) was connected to a N2 cylinder via 
silicone tubing (Tygon) and then kept close to the bottom of the centrifuge tube to perform N2 bubbling. The N2 flow 
rate was set at about 4 ml/min. N2 bubbling was let run for about 500 sec (~8 min) to reach 0% O2 of the media. N2 
bubbles got accreted at the air/media interface and were broken by keeping the needle in the bubble layer for a few 
seconds. After the N2 bubbles were removed the N2 gas trapped in the centrifuge tube was purged by a rubber bulb 
for three times to create the air (i.e. no oil) condition or was directly replaced by silicone oil (3 ml) added by pipette. 
The 3 ml of oil added on top the media in the 5 ml centrifuge tube led to about 18 mm in the oil depth. Then the 
oxygen recovery was recorded with the optical oxygen sensor until the oxygen level reached about 10% O2. The 
recorded txt. data sheets (O2 % versus time) were plotted in Excel. 
Reconditioning of the under-oil oxygen microenvironment 
(i) Regulation of mitochondrial respiration in UOMS cell culture. A 384-well plate of Caco-2 cells was prepared 
(see Preparation of mono-culture plates) by seeding 1×104 cells/well in 20 µl of culture media (EMEM + 20% FBS) 
with 5 mm silicone oil (5 cSt) overlay. The cells were cultured for 12 h to reach a starting level of POC at about 15% 
O2. A mitochondrial stress assay kit (Agilent Technologies, Seahorse XFp, 103010-100) was used to manipulate the 
mitochondrial respiration and thus the OCR of the cells. Specifically, FCCP [carbonyl cyanide-4 (trifluoromethoxy) 
phenylhydrazone] collapses the proton gradient and disrupts the mitochondrial membrane potential. As a result, 
electron flow through the ETC (i.e. Electron Transport Chain) is uninhibited, and oxygen consumption by Complex 
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IV reaches the maximum. A mixture of ROT (rotenone)/AA (antimycin A) inhibits Complex I and Complex III. This 
combination shuts down mitochondrial respiration. FCCP and the mixture of ROT/AA were reconstituted in DMEM 
culture media (not deoxygenated) to get a 50 µM and 25 µM compound solution, respectively. The POC was 
monitored in real time for 3 h by the optical oxygen sensor (see POC measurement with the optical oxygen sensor) 
with the culture plate set on a hot plate. The compound solutions were added to a well at a volume of 0.4 µl/dose [for 
a 1:50 v/v ratio (0.4 μl compound solution:20 μl media)] in a sequence (×4 doses of FCCP and ×2 doses of ROT/AA). 
To avoid introduction of air during the pipetting under oil, the pipet tip was prefilled with oil and then loaded with 0.4 
µl of the compound solution. Compounds were added to the culture media with the prefilled oil kept in the tip. 
(ii) Scratch and recovery experiment. A 384-well plate of Caco-2 cells was prepared (see Preparation of mono-
culture plates) by seeding 3×104 cells/well in 20 µl of culture media (EMEM + 20% FBS) with 5 mm silicone oil (5 
cSt) overlay. The cells were cultured for 68 h, which is sufficient for the cells to form a confluent monolayer with a 
starting level of POC at about 0% O2. A metal pin (tip Ø ≈ 200 µm, 254 nm UV sterilized) was used to scratch the 
cell layer with two largely orthogonal strokes for each well. The control group was a set of wells without scratch. POC 
was measured after cell seeding, before and after scratch with a minimum of ×3 replicates in each condition. The 
fluorescent images of hypoxia dye were taken after the POC measurements. 
Colorimetric analysis of pH in cell culture with and without oil overlay 
The test was performed with mono-culture of Caco-2 cells (see Preparation of mono-culture plates) compared to a 
no-cell control (fig. S9). The culture media (EMEM + 20% FBS) was supplemented with a pH indicator (phenol red, 
30 μM). A pH color chart was obtained using a pH meter (Model 225, Electrode Model 300731.1, Denver Instrument) 
and hydrochloric acid (1 M) titration. 10 ml of the media was added to a 50 ml centrifuge tube (Falcon, 734-0451). 
Hydrochloridric acid was added to the media to reach a specific pH reading. 20 μl of the pH-adjusted media was 
pipetted to a well of a 384-well plate and then pictured (iPhone 6s) against a white background. For the culture and 
control plates, each condition has at least ×3 replicates. The plates were pictured before and 24 h after incubation in a 
standard incubator with different exposure times (i.e. 0 min, 30 min, and 100 min) in air at RT. The color of the media 
in comparison with the pH color chart indicates the pH level of the media in a tested condition, reflecting a reduced 
CO2 diffusion from media to ambient (~0.04% CO2) with the oil overlay. 
Live-dead staining and cell viability analysis 
Cells were stained with 2 μM calcein AM (Thermo Fisher Scientific, L3224), 1 μM propidium iodide (Thermo Fisher 
Scientific, P1304MP) and Hoechst 33342 (Thermo Fisher Scientific, H3570) in appropriate culture media (table S2), 
following 24 h of culture to obtain live, dead and nuclei counts, respectively. Staining solution was prepared at 2× 
immediately before staining and diluted in culture media within wells to make 1× solution. Cells were incubated with 
staining solution for 20 min in a standard incubator prior to imaging. Fluorescence images were obtained on a Nikon 
Ti microscope and kept at 37 oC and 5% CO2 via an on-stage incubator (Bold Line, Okolab) during imaging. A 
minimum of ×3 replicate wells with live cells were averaged for viability analysis.  

The dead-channel images were threshold processed using the “Image → Adjust → Threshold (Default)” 
function in Fiji ImageJ. Threshold adjustment was carried out on the entire image including the edges of the well. 
Minimal adjustment might be applied manually if necessary to get the optimal threshold-processed images that loyally 
distinguish and pick the cells. With the seeding densities in this study (i.e. 1×104 or 3×104 cells/well of a 384-well 
plate), cell clumping could happen. The cells in a clump can not be effectively identified by the software as separate 
entities, which causes negative errors on cell count. The binary watershed function “Process → Binary → Watershed” 
in Fiji ImageJ was chosen to process the image further so that the clumps were broken into smaller particles to give a 
more accurate cell count of the true amount of cells by the software. On the processed images, particle analysis was 
carried out using the “Analyze → Analyze Particles...” function in Fiji ImageJ, which gives the cell count (of the dead 
cells in this case) in the output. In theory, the total cell count (including both live and dead cells) can be obtained by 
analyzing the nuclei-channel images. However, cell clumping became a dominant effect on the nuclei-channel images, 
which led to a severely underestimated number of the total cell count. Provided such a limit, we used the total number 
of cells in each seeding density (i.e. 1×104 or 3×104 cells/well) instead to calculate the cell viability, following the 
equation: cell viability = live cells/total cells × 100% = (total cells - dead cells)/total cells × 100%. 
Preparation of co-culture plates 
The co-culture was performed in 384-well plates [Glass Bottom (#1.5, 0.170 ± 0.005 mm, high performance 
coverglass), Black polystyrene frame, Tissue Culture Treated, Flat Bottom, 384-well plate, Cellvis, P384-1.5H-N] 
with the steps as follows: 
(i) Isolation of intestinal crypts and generation of colon organoids. All human studies were approved by an IRB at 
University of Wisconsin-Madison (Protocol# 2016-0934). Intestinal crypts were isolated from colon removed for 
nonmalignant etiology using a previously established protocol (51). Isolated crypts were embedded in Matrigel 
(Basement membrane, Corning, 354248), and cultured in 24-well plates (Polystyrene, Nunc, Non-Treated Multidishes, 
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Thermo Fisher Scientific, 144530) in intestinal stem cell media (table S2). Colon organoids were split 1:2 to 1:4 every 
2 to 3 days using a previously established protocol (52). 
(ii) Culture of colon monolayer. Based on the established protocol (52), intestinal stem cell media was removed from 
the 24-well plates containing colon organoid cultures, 500 μl of 0.5 μM ethylenediaminetetraacetic acid (EDTA) in 
phosphate-buffered saline (PBS) was added to each well and Matrigel plugs containing the organoids were harvested. 
After centrifugation at RT for 3 min at 300×g, supernatant was removed. 1 ml of 2.5 mg/ml trypsin (Sigma Aldrich, 
T4549) was added and incubated for 2 min in a 37 oC water bath. Trypsin was neutralized using media [Advanced 
DMEM/F12, Thermo Fisher Scientific, 12634-010] + 20% FBS. The organoids were broken down into small 
fragments by pipetting vigorously using filtered 1000 μl pipette 60 times. 20,000 organoid fragments (500 
fragments/μl) were seeded onto a 384-well plate coated with Matrigel that was diluted 1:40 in intestinal stem cell 
media. Media was changed every 2 to 3 days (stem cell media). After 7 days, a confluent monolayer was formed and 
the media was switched to 40 μl/well of differentiation media (for 4 mm in media depth) (table S2) and 50 μl/well of 
oil (silicone oil, 5 cSt) (for 5 mm in oil depth) was overlaid. Bacterial co-cultures were performed on the following 
day. 
(iii) Preculture and fluorescent tagging of gut anaerobic bacteria. B. uniformis (DSM 6597) was cultured in an 
anaerobic chamber (Coy Labs) with 83% N2, 2% hydrogen (H2) and 15% CO2 at 37 ºC in Anaerobe Basal Broth 
(ABB, Oxoid) for all steps except conjugation. During the conjugation procedure, B. uniformis was cultured in Brain 
Heart Infusion Broth (BHIS, Sigma Aldrich). The conjugation donor E. coli strain BW29427 was obtained from the 
E. coli Genetic Stock Center (CGSC). This strain was grown aerobically in Luria Bertoni (LB, Sigma Aldrich) media 
containing 25 mM of 2,6-Diaminopimelic acid (DAP, Sigma Aldrich). The E. coli strain BW29427 was transformed 
with the plasmid pWW3515 that harbored the fluorescent reporter mCherry expressed from the BfP1E6 promoter 
(53). The pWW3515 plasmid encodes the IntN2 tyrosine integrase, which mediates recombination between the attN 
site on the plasmid and one of the two attBT sites on the B. uniformis chromosome (54–57). Following the 
transformation, single colonies were inoculated into LB containing 100 µg/ml carbenicillin (Carb, IBI Scientific) and 
DAP and incubated at 30 ºC overnight. Cell pellets were collected by centrifugation at 4,000 rpm for 5 min and washed 
with fresh LB media. The E. coli cells were then combined with the B. uniformis culture (OD600 = 0.5~0.6) at a 
donor:recipient ratio (v/v) of 1:10. The cell mixture was pelleted, resuspended in 0.2 ml BHIS and then spotted on 
BHISAD (BHIS + 10% ABB + DAP) agar plates and incubated anaerobically at 37 ºC for 24 h. The cell lawns were 
scraped and resuspended in BHIS and plated as serial dilutions on BHISAGE plates [BHIS supplemented with 10% 
ABB, 200 µg/ml gentamicin (Sigma Aldrich) and 25 µg/ml erythromycin (Sigma Aldrich)] and incubated 
anaerobically at 37 ºC for 2 days. The engineered strain was verified by colony PCR. Bacterial inoculum onto the 384-
well plate was captured in exponential phase, diluted to an OD600 of 0.1 in the culture media (e.g. the differentiation 
media for primary colon epithelium).  
(iv) Co-culture of colon monolayer with gut anaerobic bacteria. The bacterial inoculum stock (OD600 = 0.1) was 
prepared in the anaerobic chamber and transported in an anaerobic Hungate tube (VWR, 100484-346). The following 
inoculation was performed in air in a sterile biosafety hood. An eppendorf tube (Polystyrene, 0.6 ml) was prefilled 
with 300 μl of silicone oil (5 cSt). 100 μl of the bacterial inoculum was transferred from a Hungate tube to under oil 
in the eppendorf tube using a syringe (1 ml, Luer-lok Tip, BD Biosciences, REF 309628). Bacteria were added to the 
media above the colon monolayer by pipette at 1:20 v/v ratio (2 μl bacteria:40 μl media) carefully so as not to disrupt 
the oil overlay. Mono-culture conditions (including bacteria only and colon monolayer only) with and without oil 
overlay were prepared in parallel as control. Following the inoculation, the culture plates were kept in a standard 
incubator and cultured for 24 h. 
Downstream characterizations in co-culture 
(i) RT-qPCR (colon monolayer). After 24 h of co-culture, the overlaying oil and media were carefully removed and 
each well was washed with Dulbecco’s PBS (Thermo Fisher Scientific, 14190250). To each well, 20 μl of Buffer RLT 
plus + β-mercaptoethanol (Sigma Aldrich, M3148) was added to lyse the cells. RNA was isolated using Qiagen 
RNeasy Plus Micro Kit (Qiagen, 74034) according to the manufacturer's protocol and quantified with a pico chip on 
an Agilent Bioanalyzer (Santa Clara, CA). Reverse transcription was conducted with the RNA to cDNA kit (4387406, 
ThermoFisher Scientific). A preamplification step that amplifies the amount of cDNA available for downstream RT-
qPCR analysis was conducted using SsoAdvanced PreAmp Kit (BioRad, 1725160). RT-qPCR was performed using 
TaqMan Gene expression assays (Thermo Fisher Scientific) with LightCycler 480 Probes Master (Roche Diagnostics). 
A 20 μl total  reaction volume was used with 1 μl of 20× TaqMan primer-probe mix, 10 μl of 2× LightCycler 480 
Probes Master mix, and 9 μl of cDNA diluted in RNase-free water. RT-qPCR amplification was monitored using a 
LightCycler 480 (Roche Diagnostics). qPCR was performed on 6 target genes and 3 reference genes (table S3). The 
reference genes were selected based on constitutive and stable expression across sample types. After incubation at 
95 °C for 10 min, the reactions underwent 45 cycles as follows: 10 sec at 95 °C, 30 sec at 60 °C, and 1 sec at 72 °C. 
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Genes with Ct ≥ 35 were excluded. The Ct values were normalized to the reference genes (GAPDH, HPRT and 
RPLP0). Quantification of results (Fig. 5F) are presented as: ΔCt = [CtGene- mean(CtGAPDH, CtHPRT, CtRPLP0)] 
so that positive values represent low expression and negative values represent high expression compared to the 
reference genes. 
(ii) Immunostaining (colon monolayer). The cells on a 384-well plate were fixed first by adding 40 μl of 4% 
paraformaldehyde (PFA) to each well and then incubated at RT for 10 min. After the PFA solution was removed by 
pipette, the fixed cell layer was washed with 100 μl of 1× PBS for three times. After fixation, the cells were 
permeabilized by adding 40 μl of 0.1% Triton X-100 to each well and then incubated at RT for 5 min. After the Triton 
solution was removed by pipette, the permeabilized cell layer was washed with 100 μl of 1× PBS for three times. After 
permeabilization, a blocking buffer consisting of 3% bovine serum albumin (BSA), 5% human serum, and 0.1 M 
glycine in 0.1% PBST (1× PBS with 0.1% added Tween 20) was added to each well at a volume of 80 μl. The plate 
was stored in a cold room overnight at 5 oC to prohibit nonspecific binding of antibodies in the following staining 
process. Before staining, the blocking buffer was removed by pipette and the wells were washed with 100 μl of 1× 
PBS for three times. A staining buffer was prepared utilizing 3% BSA in 0.1% PBST and 10% of a 1% Tween 20 
solution at a 1:25 or 1:50 concentration with a primary antibody [(DAPI, 1:2500 dilution, Thermo Fisher Scientific, 
D3571), (F-actin, 1:500 dilution, Thermo Fisher Scientific, T7471), (Rabbit polyclonal anti-FABP1, 1:25 dilution, 
Sigma Aldrich, HPA028275), (Mouse monoclonal anti-MUC2, 1:50 dilution, Santa Cruz Biotechnology, sc-515032), 
(Villin, Novus Biologicals, NBP2-53201), (Rabbit polyclonal anti-ZO-1, 1:25 dilution, Thermo Fisher Scientific, 61-
7300), and (Mouse monoclonal anti-E-cadherin, 1:25 dilution, BD Biosciences, 610182)]. The staining buffer and 
accompanying antibody were added at a volume that was just large enough to cover the cell layer at the bottom of 
each well (~10 μl). The plate was stored in a cold room overnight at 5 oC. Removal of the buffer was followed by two 
washes of 0.1% PBST of about 100 μl/well. A secondary antibody [488-anti-mouse, 1:250 dilution, Abcam, 
ab150105) or (647-anti-rabbit, 1:250 dilution, Abcam, ab150075)] depending on the compatibility of the original 
primary antibody was mixed with the staining buffer at 1:250 concentrations along with a 1:5000 concentration 
(sometimes 1:3000 depending on available product) of DAPI to stain the nuclei and a 1:500 concentration of 
rhodamine phalloidin to stain the (F-actin) cytoskeleton. This final staining solution was added to each well at a 
volume of 10 μl/well and then the plate was incubated for 1 h at RT while protected from light using aluminium foil. 
Following the incubation, the wells were washed with 0.1% PBST for two times before imaging. 
(iii) Fluorescent/confocal microscopy. The fluorescent images and videos were taken on a Nikon Ti Eclipse at 4×, 
15× (10× objective with the 1.5× tube lens), and 30× (20× objective with 1.5× tube lens) magnifications with bright 
field and fluorescent channels, including 390 nm/440 nm [Excitation (Ex)/Emission (Em)] for nuclei (DAPI); 485 
nm/525 nm for hypoxia dye (Image-iT Green Hypoxia Reagent), live dye (calcein AM), goblet cells (MUC2), 
microvilli (Villin); 560 nm/607 nm (Ex/Em) for dead dye (propidium iodide), mCherry, and cytoskeleton (F-actin); 
and 648 nm/684 nm for tight junction (ZO-1). Maximum laser power was applied if not stated otherwise. 3D confocal 
images were acquired with a Nikon A1-Si laser-scanning confocal microscope (Nikon Instruments). 
(iv) Bacteria count. The 30× magnification fluorescent images were threshold processed using the “Image → Adjust 
→ Threshold (Triangle)” function in Fiji ImageJ. And then the bacterial cells were picked up and counted using the 
“Process → Find Maxima...” function in Fiji ImageJ. A prominence threshold was applied to each image to reach an 
optimal pickup of the singal (i.e. cells) against the noise (i.e. background). The bacteria count results were averaged 
with a minimum of ×3 replicates of each condition and plotted in Prism GraphPad. Note that B. uniformis stably 
express the mCherry proteins at low density (e.g. at early time points after inoculation). However, at 24 h, B. uniformis 
grew into a highly dense layer in co-culture, mostly losing their fluorescence due to the repressed expression of 
mCherry in low oxygen levels. The bacteria showed up in the bright-field as bright dots (i.e. the pole of the rod-shaped 
bacteria) with a clear contrast against the background, squirming around in Brownian motion. The bright-field images 
were threshold processed and rendered with pseudo red color to visualize the bacteria (Fig. 5E), and used instead in 
the bacteria count for B. uniformis at 24 h in co-culture.  
Cell line authentication 
(i) The mammalian cell lines (Caco-2, MDA-MB-231, HUVEC, and THP-1) were authenticated using short tandem 
repeat (STR) analysis. The STR analysis was performed with a cell pellet of about 2 million cells spun down with the 
media removed. The results were compared to an online database (e.g. Lonza, ATCC) to confirm the identity of a cell 
line. 
(ii) Sanger sequencing (Functional Biosciences, funding NIH) of 16s rRNA gene from colony picks of a single 
morphology quadrant streak was used to confirm identity of the bacteria (B. uniformis) in the co-culture experiment. 
27 Forward (2_27F universal 16s rRNA gene forward primer) and 1492 Reverse (2_1492R universal 16s rRNA gene 
reverse primer) were used. Blast returns B. uniformis as top match in both cases, with 99.58% and 100% identity. 
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SUPPLEMENTARY MATERIALS 
table S1. Reported oxygen solubility and diffusivity of materials used or referred in this study. 
table S2. Compiled information of cell types and culture media. 
table S3. The panel of genes in RT-qPCR and related protein function. 
fig. S1. Oxygen levels and representative kinetics of supply-demand-defined oxygen microenvironments. 
fig. S2. Cell viability of Caco-2 cultured with and without oil (silicone oil, 5 cSt) overlay (24 h after cell seeding with 
hypoxia dye). 
fig. S3. Oxygen diffusion test of silicone oil with different viscosities. 
fig. S4. POC of Caco-2 from the condition of large media volume (40 μl/well on a 384 well plate for 4 mm in media 
depth) without oil overlay. 
fig. S5. Comparison of hypoxia generation in PDMS microchannels with and without oil overlay.  
fig. S6. Cell viability of different cell types cultured under oil (24 h after cell seeding with and without hypoxia dye). 
fig. S7. Immunofluorescence staining (IFS) images of primary colon epithelium from mono-culture (no-bacteria 
control) and co-culture with B. uniformis under oil on Day 9 (i.e. 24 h after inoculation of the bacteria). 
fig. S8. Comparison of hypoxia generation between silicone oil (5 cSt) and fluorinated oil (Fluorinert FC-40). 
fig. S9. Colorimetric analysis of phenol red in culture media before, after incubation and exposure in air. 
 
All data needed to evaluate the conclusions in the paper are present in the paper and/or the Supplementary Materials. 
Additional data available from authors upon request. 
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